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Word Processing: Word 2007

These instructions are for an IBM compatible Personal Computer using Word 2007. Word 2007
It is assumed that you can switch your computer on and launch an application. o

Although the basic functions of Word 2007 are very similar to earlier version of Word the way it is
controlled is significantly different as the icons are now in a tabbed structure. Users of earlier version of
Word should consult “Word Processing the Basics”.

As with all Windows based systems there are always a variety of different ways of carrying out the same
task. This document will use the quickest or simplest. If you uncertain of the purpose of any icon hover
the cursor over it for a few seconds and a description will appear.

> Launching your Word Processor
If you have an icon for your Word Processor on your desktop double click on it to start it. T
=
If not use the Start button or Windows button at the bottom left of the screen to access the list of
applications on your machine (if you are not sure about this look at the Zero Point handout.)

> Tabbed Icons
The essential difference between Word 2007 and earlier version is the use of Tabbed icon bar, which
Microsoft somewhat confusingly calls ribbons. Rather than all icons being available simultaneously
they are grouped by usage onto separate tabs.
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This is part of the Home tab.

Other tabs are selected by clicking on their names; Insert, Page Layout etc. This does means that
one has to guess on which tab features options are grouped, although they are fairly logical. The
visible tab may change as you carry out various tasks as Word tries to second guess which facilities
you might need. (I will let you know what tab to use by the message [XXXX tab].

Many of the features which were found under the File Menu on older versions of Word are now
behind the Office button on the top left of the screen.

There is also a Quick Access tool bar which has, by default, very small icons of Save, Undo, and Redo.
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This toolbar is usually to the right of the Office button but in the example above it have been move
to a position below the tabs and a number of other icons have been added.
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Note the small arrows which appear at the corners of many icon groups. Clicking on these gives you
access to many of the dialogue boxes familiar from earlier version of Word.

Basic Operations

> Creating a new Document
When you launch your WP you will usually be presented with a blank document, the

equivalent of a blank sheet of paper. If for some reason you don’t get a blank | 03 ;
document, click on the office button on the top left of the screen =
Select New

Select Blank document and click on the Create button
(You may get lots of choice of possible documents to open)
NB you can have more than one document on screen at a time.

> Inputting text
At this stage you can treat the Word Processor like a typewriter. One big difference is that you do
not have to concern yourself with carriage returns. The WP will automatically wrap the text
onto the new line. If you want to deliberately start a new line then press the Return <::|]
Key

TASK
Launch your Word Processor
Type 3 lines of text; it can be anything you wish.

> Correcting Errors

If you make an error just click on the Undo icon = Lf’ 5
You will find this on the Quick Access Tool bar

There are two correction keys
The delete key; which will delete any highlighted text.

The backspace key; (above the return key), which deletes the character just before the cursor
position.
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> Saving a document
To save a document click on the Save icon. =
You will find this on the Quick Access Tool bar

=

If the document already exists it will be over written with this new copy

If the file is completely new:- SEVEIRS 2]x]
A dialogue box will open = saveln; | My Documents M e 2 xodE-
. . . Trusted lame ize e Date Modified [~
[We will consider dialogue boxes later] O remiaes QNAU_FF_Downloads i FTiI;pFoIder 18/07/2008 06:18 ‘
) "D"V Rm’;‘ Da171 File Folder  21j08/2007 10:48
oeuments LA175 File Folder 11/04/2007 22:01
. o 2} Deskt ) ALPanel File Folder  05/12/2008 09:12
You will be prompted for a file name. ‘9 ” | Sy FieFoldr 04151200 1541
H H H .J [)Angela File Folder 15/06/2009 15:17
(Word will make a suggestion which can be Jazcumems Sode Fle s 1fs209 1517
1 @ t () Audio File Folder ~ 17/06/2009 22:26
overwritten) - Mzn;p;;;rk )Bolg File Folder  10/10/2007 11:11
The Computer W||| assume you Want tO 3p|aces ) Career File Folder  04/06/2007 18:55
h fl . h f | d I b File name: Agenda 23 June 2007.doc v
store the file in the folder you used last, but SncH i [T ———— g
this can be changed.
&
TASK
Save your document (Remember the name) X
Close down your Word Processor
> Opening an existing document
Click on the Office button = C“

A dialogue box will open
Click on Open
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A dialog box will open which will enable you to look at all the documents in your folders.
Select the one you want by double clicking on it.
You may have to navigate about the computers file structure

TASK
Close down the document; (top right of Window) but not the Word Processor X
NB this will actually close down the Word Processor if you only have one document open
If you were recently working on a ) Word Processing Word 2007_A.doc [Cor
document: '%;
lick on the Offi n

Click on the Office butto : Recent Docmments

j New
The last few documents you were working 1 Word Processing Word 2007_A.doc

7 Open = =

that appe.ars.'=> _ o 3 Web Searching_A.doc
Double click on the name to open it. .

iw 4 PCZero.doc

- Conyert

5 ICT Booklet 2 D2.doc
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Editing Text

> Highlighting text
Before editing any area of text you need to indicate the area you wish to work on. This is done by
highlighting the text.
® Position the cursor at the beginning of the section you wish to highlight
® Hold down the left mouse button
® Move the cursor over the area you wish to highlight
® Then release the mouse button
This requires some practice to do accurately!

> Formatting text
Having highlighted the text, click on the appropriate icon to change the format of the area
highlighted:-

Justify text to the left [Home tab]

Centre justify text [Home tab]

Justify text to the right [Home tab] Equally justify text [Home tab]

TASK
Make a right justified letter head with your address

Fonts
You may know fonts as typefaces. Computers are only limited in the number of fonts they have by
the printers they have connected to them. You may have the font type and size buttons already set
up on your toolbar.

Calibri . Change font type (The arrow on the right gives drop down list)

[Home tab]

Change font size (The arrow on the right gives drop down list)
11 v
[Home tab]
This text is in Times New Roman 11point.
This text is in Arial 9 point.
This document has been produce in Calibri 11 point

TASK
Choose a new font for your address and apply it.
Then make it slightly larger

Underlining was the traditional method of making a section of a document more visible; but with the
advent of computers the bold facility is now more common.

e Underline text [Home tab]

B Mak Id [H
ake text bold [Home tab] — The black arrow gives formatting options

oF Make text italic [Home tab]

TASK
Modify your document to a business letter address the gas board querying your last gas bill.
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> Checking Spelling and Grammar
You can check the spelling and grammar (approximately) of your document

First select the Review Tab \/9
Then click on the spell check icon. = Spelling &
This will check the whole document. Grammar

If you only want to check part of a document, highlight that part before clicking on the icon.

If continuous checking has been enabled on your machine any spelling errors will be underlined in
red (and grammar errors underlined in green).

To correct these errors position the cursor on the erroneous word and right click the mouse.
Select the correction you require with a left click of the mouse.

> Copying text
Highlight the text you wish to copy and click on the copy icon.[Home tab]= . Coov
The text is stored on a ‘clipboard’ ready to be pasted into its new position. 43 Py

> Pasting text

To paste text; position the cursor where you want the text placed =)
Click on the paste icon [Home tab]. = _]
The black arrow gives you some additional options Paste
TASK

Open a new document (but don’t close the old one).
Copy your letterhead onto this new document

And change the colour of the text

Hint: Its on the Home tab

> Saving an existing document with a new name
Click on the Office button
Select Save As from the drop down list
A dialogue box will open [See later for more information on dialogue boxes]
You will be prompted for a file name and a location to store the new file

TASK
Save this new document with the name LetterHead

> Cutting text
You can use the cut facility to move text to another position.
Highlight the text you wish to cut and click on the Cut icon [Home tab]. = 5 Cut
The text is stored on a ‘clipboard’ ready to be pasted into its new position.

TASK
Open a new document (but don’t close the old one).
Copy your letterhead onto this new document

Printing a document

> Set-up
Before printing a document it is as well to check that the Word Processor has been set up correctly.
At the Menu Bar click on File and then Print Setup.
Three tabs are available Margins, Paper and Layout.
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® Margins enable you to set the paper orientation, and the margin sizes (+++)
® Paper enables you to set the paper size (almost invariably A4) and the printer tray
® Layout allows you to do fancy things with headers and footers.

> Viewing the document
Before finally printing a document you may wish to see what it looks like on the page, something that
can be difficult to visualise from the standard screen view.

Click on the Office Button (= e , | Preview and print the document

. . . Prin
Click on the black arrow beside the Print i} Pprint
icon b H’g,d Select a printer, number of copies, and

. . . . 7| Prepare » other printing options before printing.
Click on the Print Preview icon that . - b . -

[ ick Print
subsequently appears = fatf, Quic
q yape 8 send N H’z,hj Send the document directly to the default
= printer without making changes.
5 Print Preview
o Publish  » “j Preview and make changes to pages before
printing.

The screen will change to a preview mode. —

You can change the size of the image using the 50% @ O - (-I-)

slider at the bottom right of the screen =
NB this size slider is available in your normal working mode.

Close Print
Preview

Return the screen to its normal view by clicking on the Close icon =

> Printing the document
If you wish to print the whole document
Click on the Print icon on the Quick Access Tool bar = i @

OR if you wish to print part of a document or want to print more than one copy
Click on the Office Button

Click on the black arrow beside the Print icon

Click on the Print icon that subsequently appears =

Chose the appropriate options from the dialogue box that appears.

TMAs (Tutor Marked Assignments)

See the TMA template for more information

IMPORTANT

The Open University does not accept standard Word 2007 documents (in a format know as .docx)
submitted through the electronic TMA system. They must be in the slightly older format associated with
Word 97 — 2003 (known as .doc). This is very easy to manage.

When saving the document change the Save as type field as shown below.
|

File name: |X123456789_TMA01|.d0c
Save as type: IWOrd 97-2003 Document (*.doc) l:”
I Save I [ Cancel ]
7
PTO
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> Dialogue boxes
Dialogue boxes are one of the ways your PC tries to understand what you want it to do. They appear
in a variety of different circumstances but although their purpose may be different, each time the
basic operating principles remain the same.
This is the dialogue box given when you attempt to save a document with a new name.

- 1
SAVEWLS J \3
Save in: () My Documents l_ O - X Cu B~
= Trusted MName Size Type Date Modified (~]
! Templates y ‘
|.2)AD_FF_Downloads File Folder ~ 18/07/2008 06:18
) ’[‘)"Zc*zf::n“tts 2a171 File Folder ~ 21/08/2007 10:48
La175 File Folder 11/04/2007 22:01
u;f} Desktop | aLPanel File Folder  05/12/2008 09:12
M D alks File Folder  04/08/2008 15:41
(= 4 I Angela File Folder 15062009 15:17
Documents
My I Arts Club File Folder  02/03/2009 19:18
') Computer |2 Audio File Folder 17/06/2009 22:26
© 3 My Network | 2)Bolg F?Ie Folder  10/10/2007 11:11
Places ) Career File Folder ~ 04/06/2007 18:55
File name: Agenda 23 June 2007.doc &
Save as LyPe! |word 97-2003 Document (*.doc) v
(] (o
The buttons along the top are a series of useful function:-
&) Access recently used folder (greyed out so it is not available in this case)

3 Move up one level in the folder structure

Deleted the selected folder (greyed out as no folder has been selected)

Create a new folder within the existing folder

v Change the format of the information being displayed

File name: is where (in this case) you enter the name you wish the file to be called
(Word always makes a suggestion which you can overwrite)
Save As Type: is where (in this case) you choose the file type you wish to save.

All applications will suggest a preferred file type.

NB Other dialog boxes will have different features depending on their particular purpose.
Additional Information

> Free online Word 2007 Tutorials
® From the Baycon group
® From Microsoft
® Google video tutorials

http://www.baycongroup.com/wlesson0.htm
http://office.microsoft.com/en-us/training
http://video.google.com
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